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Block 3:  Analysing two variables (and sometimes three)  Multiple response 
 

3.3.2a  [SPSS 15]  First exercise in multiple response [1990, Updated 20 July 2011] 

 
For a general discussion of multiple response questions (ie "Tick as many as apply") and how to 

analyse them with SPSS, see 3.3.1 Multiple response and SPSS: an introduction. 
 
[NB: I’m working on a new version of this tutorial for SPSS 19] 
 
Exemplar: Pre-course questionnaire on interests and experience  
 
Task 1: Produce a grouped frequency table for the multiple responses to Q.4 (previous 

experience of keyboard, statistics, computing etc) of the Questionnaire on pre-
course interests and experience.   

 
Task 2: Tabulate these by sex, first for a simple count, second to include appropriate 

percentages. 
 

 
Q4.  Have you had training or practical experience in any of | 

     the following?    (Tick as many as apply)               | (16-20) 

                                                        __   | 

                                               Typing  |__|  |   1 

                                                        __   | 

                                       Wordprocessing  |__|  |   2 

                                                        __   | 

                                    Social Statistics  |__|  |   3 

                                                        __   | 

       Survey analysis using SPSS or similar packages  |__|  |   4 

                                                        __   | 

                           Other computing experience  |__|  |   5 

                           (Please specify)                  | 

[Extract from questionnaire] 

 
The cumulative raw data (from questionnaires completed by six successive waves of students) are 
contained in file myclass.txt on this site.  There is a single record for each case and the codes for 
Q4 are entered as numeric integers in columns 16 to 20.  It doesn't matter how many codes (up to 
a maximum of five) are entered in these five columns or in which order.  Although the codes on 
the questionnaire are in the range 1 to 5, there are some cases with a code 6 in column 16 (as in 
the data extract below).  This code was added later to indicate "None of the above" (i.e. no boxes 
ticked). 
 
[Extract from raw data] 
 

36 23514 222 5 12    1 2 38      5 10 

37 12435 232 5 12345 2 1 35      5  5 

38 15324 223 3 1235  1 1 69      6  0 

39 12543 223 4 6     2 1 31 1.65 

40 13524 233 4 123   2 1 24      5  9 

41 34215 224 5 25    1 1 38      6  1 

42 14253 213   125   2 3 37      5  4 

43 25431 323 2 12345 1 2 30      6  0 

44 35421 213 2 1235  2 1 40      5  1 

45 24315 122 3 3     1 1 31      5 10 

http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/3.3.1__analysing_multiple_response_with_spss_-_an_introduction.pdf
http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/1.1.1_pdf_class_fun_questionnaire.pdf
http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/myclass.txt
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The data were entered into SPSS using the positional convention for variable names (see: 1.3.1 
Conventions for Naming Variables in SPSS) in this case V16 TO V20, and are stored with full 
dictionary information in the SPSS saved file myclass3.sav on this site. 
 
One way of analysing these questions is to produce frequency counts for each one and then add 
them together by hand. 
 
freq v16 to v20 . 
 

v16 

 
Frequency Percent Valid Percent 

Cumulative 
Percent 

Valid Typing 105 62.1 70.0 70.0 

Word-  process 19 11.2 12.7 82.7 

Social statistics 11 6.5 7.3 90.0 

Other 6 3.6 4.0 94.0 

6 9 5.3 6.0 100.0 

Total 150 88.8 100.0  

Missing System 19 11.2   

Total 169 100.0   

 

v17 

 
Frequency Percent Valid Percent 

Cumulative 
Percent 

Valid 1 1 .6 .8 .8 

2 109 64.5 85.2 85.9 

3 4 2.4 3.1 89.1 

4 7 4.1 5.5 94.5 

5 7 4.1 5.5 100.0 

Total 128 75.7 100.0  

Missing System 41 24.3   

Total 169 100.0   

 

v18 

 
Frequency Percent Valid Percent 

Cumulative 
Percent 

Valid 2 2 1.2 2.8 2.8 

3 46 27.2 64.8 67.6 

4 2 1.2 2.8 70.4 

5 21 12.4 29.6 100.0 

Total 71 42.0 100.0  

Missing System 98 58.0   

Total 169 100.0   

 

v19 

 
Frequency Percent Valid Percent 

Cumulative 
Percent 

Valid 4 19 11.2 76.0 76.0 

5 6 3.6 24.0 100.0 

Total 25 14.8 100.0  

Missing System 144 85.2   

Total 169 100.0   

 

v20 

 
Frequency Percent Valid Percent 

Cumulative 
Percent 

Valid 5 37 21.9 100.0 100.0 
Missing System 132 78.1   

Total 169 100.0   

http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/1.3.1_conventions_for_naming_variables_in_spss.doc
http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/1.3.1_conventions_for_naming_variables_in_spss.doc
http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/myclass3.sav
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You can also get a summary table like the one below (see Appendix on p.18 for how to do this) :  

 

 

Q4:  
(col 16) 

Q4:  
(col 17) 

Q4:  
(col 18) 

Q4:  
(col 19) 

Q4:  
(col 20) 

Count Count Count Count Count 

1 105 1       

2 19 109 2     

3 11 4 46     

4   7 2 19   

5 6 7 21 6 37 

6 11         

 

 
Adding these tables together by hand could be tedious and error prone, but SPSS  has a special 
procedure to handle this kind of data. 
 
The SPSS command MULT RESPONSE effectively makes up five separate tables (one for each 

variable V16 to V20) and then adds them all up into a single table.  To do this it creates a 
temporary group variable which cannot be saved, but has to be re-created each time you want 
to use it in an SPSS run.  It can only work in "integer mode" and so the values of any variables to 
be included in the groups have to be in numeric integer format (ie whole numbers with no decimal 
places).   
 
The general format of the multiple response "group" specification is: 
 
 MULT RESPONSE GROUPS =  
   <group variable1> [ ' <label> ' ] 
    ( <source variable list1> ( <min> , <max> )) 

/<group variable2> [ ' <label> ' ] 
 ( <source variable list2> ( <min> , <max> )) 

                  
in which items in <chevrons> are user supplied, items in [square brackets] are optional  and 
items in bold (commands, keywords, brackets, slashes and primes) are compulsory. 

 
Thus to specify a group variable for previous training or experience : 
 

mult response groups = 
   Q4 'Previous experience and skills' 

  (v16 to v20 (1,6))  
 
[NB: Don’t forget the double brackets: leaving a bracket off is a common source of error] 

 
If any ordinary variables are to be used for tables, they need to be declared with a range of values 
indicated by a pair of values separated by commas.  
 
  / var sex (1,2)  
 
The analyses available are frequency counts and contingency tables, but they need to be 
specified in a slightly different way as sub-commands in the specification field.   
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For the frequency table in this exercise the general format of the sub-command is: 

 
   / FREQUENCIES = <group variable>  
 
eg   / freq q4 . 
 
. . and for contingency tables: 
 

   / TABLES = <group variable> BY <varlist> 
 
eg   / tab q4 by sex . 

 
If you want percentages in the contingency tables they have to be requested using a  / CELLS 
sub-command just as in CROSSTABS.  (Default base for percent is the number of valid cases.) 
 
eg   / tab q4 by sex 
   / cel col . 
 
Note:     The original variables for most multiple response sets will rarely be used as such, and do 
not normally need variable labels (unless you are using dichotomous mode).  In MULT 
RESPONSE the group labels are entered (optionally) in the same way as variable labels, i.e. as 
labels in single primes.  Value labels need be declared only for the first variable in the set. 
 
Worked example  
 
[NB: You'll need licenced access to SPSS if you want to do these exercises yourself, but you 
can still follow the logic and process by reading on] 

 
If you've done the exercises in 1.3 1 and 3 1.4 you should have a folder myclass on your desktop 
with the SPSS saved file myclass3.sav.  
 

 
 
If you're coming directly into this tutorial, you'll need to download file myclass3.sav and save it to 
your own computer.  SPSS will not open it directly from this site. 
 
 

http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/myclass3.sav
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Step 1: Double click on myclass3.sav. 

 

 
 
[NB:  This is an early stage of the file, before certain levels of measurement are defined or 
changed from nominal to ordinal or scale.] 

 
We're only interested in v16 to v20 and we can't see the labelling.  We don't need all the 
columns either so adjust the display to your liking by reducing the height of the pane and 
adjusting the column widths to make it easier to see what you are doing. 
 

 
 
[NB: By default , SPSS only reads the value labels from the first variable in the list, v16: there are 
no value labels for v17 to v20 as they'll only be used in multiple response tables] 
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Step 2: Open a new syntax file 

 
File…   New …   Syntax 

 

 
 
 

 
 
Give your job a title and type in the command for the grouped frequency table: 
 
title 'Multiple response exercise for 3.3.2' . 
mult response groups = 
 Q4 'Previous experience and skills' 
  (v16 to v20 (1,6)) 
 /frequencies q4 . 
 

 
 
[Don't forget the full stop!] 
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Run > All 
 

 
 
. .  to get: 

Case Summary 

 

Cases 

Valid Missing Total 

N Percent N Percent N Percent 

Q4
a
 167 98.8% 2 1.2% 169 100.0% 

a. Group 

 
Q4 Frequencies 

 
Responses Percent of 

Cases N Percent 

Q4
a
 Typing 106 25.8% 63.5% 

Word-  process 130 31.6% 77.8% 

Social statistics 61 14.8% 36.5% 

Survey analysis 28 6.8% 16.8% 

Other 77 18.7% 46.1% 

6 9 2.2% 5.4% 
Total 411 100.0% 246.1% 

a. Group 
 

From this you can see that there are 169 cases in the file, of whom 2 have not answered the 
question and 9 (code 6) had no previous experience at all of any of the skills listed.   The total 
number of boxes ticked is 402 (413 minus 11)  The percentage of cases totals more than 100% 
because people ticked more than one box. 

 
Step 3: 
 
For the cross-tabulation by sex, go back to the syntax file, copy and paste the first three lines: 
 
mult response groups = 
 Q4 'Previous experience and skills' 
  (v16 to v20 (1,6)) 
 
 and add the following (use space or tab to inset): 

 
 / variables sex (1,2)  
 / tables q4 by sex . 
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[CTRL]R to run and produce… 

 

Q4*sex Crosstabulation 

 
sex 

Total Male Female 

Q4
a
 Typing Count 26 80 106 

Word-  process Count 39 91 130 

Social statistics Count 15 46 61 

Survey analysis Count 10 18 28 

Other Count 24 53 77 

6 Count 3 6 9 

Total Count 50 117 167 

Percentages and totals are based on respondents. 

a. Group 

 
To add percentages to the table, go back to the syntax file, delete the full stop and add: 
 
 /cel col . 

 
[ Use space or tab to inset and don't forget the full stop! ] 
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Run the job to produce: 

 
 

Q4*sex Crosstabulation 

 
sex 

Total Male Female 

Q4
a
 Typing Count 26 80 106 

% within sex 52.0% 68.4%  
Word-  process Count 39 91 130 

% within sex 78.0% 77.8%  
Social statistics Count 15 46 61 

% within sex 30.0% 39.3%  
Survey analysis Count 10 18 28 

% within sex 20.0% 15.4%  
Other Count 24 53 77 

% within sex 48.0% 45.3%  
6 Count 3 6 9 

% within sex 6.0% 5.1%  
Total Count 50 117 167 

Percentages and totals are based on respondents. 
a. Group 

 
This table can be made easier to interpret by double clicking on the table in the SPSS output 
window to go into pivot editing mode: 
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with a small pane displayed 
 

 
 
Click on Statistics next to Varname1 
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. . . and drag it to the empty box under Varname2 
 

 
 

 

 
 
[In SPSS 15 it looks like this] 
 
If you hover the mouse pointer over the small icon on the right in the Row bar at the bottom of the 

pane you will see it indicates  Statistics  .  Hold the left mouse button down on the icon and drag it 

to the Columns bar at the right edge of the pane: 
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…and the table will change: 

 

 
 
Closing the pivot editor leaves this table in the viewer: 
 

Q4*sex Crosstabulation 

 

sex 

Total Male Female 

Count % within sex Count % within sex Count 

Q4
a
 Typing 26 52.0% 80 68.4% 106 

Word-  process 39 78.0% 91 77.8% 130 

Social statistics 15 30.0% 46 39.3% 61 

Survey analysis 10 20.0% 18 15.4% 28 

Other 24 48.0% 53 45.3% 77 

6 3 6.0% 6 5.1% 9 

Total 50  117  167 

Percentages and totals are based on respondents. 

a. Group 
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The pivot table can also be edited to delete the count columns and just leave the percentages, but 
this means you lose the base for percentaging within sex. 
 
Edit > Edit Content > In Viewer [or In Separate Viewer] 
 

 
 
 
 

 
 
You have to fiddle around a bit to get used to it, and possibly go out of pivot and back in to delete 
the other count column.   
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You can then slide the column markers to produce: 
 

 
 
Closing the pivot editor leaves this table in the viewer: 

 
Q4*sex Crosstabulation 

 
sex 

Total Male Female 

% within sex % within sex   

Q4
a
 Typing 52.0% 68.4% 106 

Word-  process 78.0% 77.8% 130 

Social statistics 30.0% 39.3% 61 

Survey analysis 20.0% 15.4% 28 

Other 48.0% 45.3% 77 

6 6.0% 5.1% 9 
Total   167 

Percentages and totals are based on respondents. 
a. Group 
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The table can be edited manually to move the headers around and manually add the base for 
percentages. 

 
 Q4*sex Crosstabulation 
 

  Q5: Sex of respondent 

 Previous experience and 
skills(a) Male Female 

  % within sex % within sex 

 Typing 52.0% 67.2% 
  Word-   process 78.0% 76.5% 
  Social  stats 30.0% 38.7% 
  Survey  analysis 20.0% 15.1% 
  Other 48.0% 44.5% 
  None of these 6.0% 6.7% 

 
(n = 100%) 

 
(50) (119) 

Percentages and totals are based on respondents. 
a  Group 
 

You can also tabulate mult response group variables with other group variables (there aren't any 
in this data set) or with themselves, as below,  
 

 
 
but this only shows combinations of pairs of skills, not of three or more.   

 
Q4*Q4 Crosstabulation 

 
Q4

a
 

Total Typing 
Word-  

process 
Social 

statistics 
Survey 
analysis Other 6 

Q4
a
 Typing Count 106 97 39 16 53 0 106 

Word-  process Count 97 132 46 25 64 0 130 

Social statistics Count 39 46 61 20 26 0 61 

Survey analysis Count 16 25 20 28 20 0 28 

Other Count 53 64 26 20 77 0 77 

6 Count 0 0 0 0 0 9 9 

Total Count 106 130 61 28 77 9 167 

Percentages and totals are based on respondents. 

a. Group 
 

[NB: When copied from the viewer, the table is too wide to fit the page.  I had to reduce the font 
size and line-spacing, then slide all the column separators to get this] 
 

 [End of tutorial] 
 
Next tutorial: 3.3.3  Multiple response questions in the 1986 British Social Attitudes survey 

http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/3.3.3a__multiple_response_questions_in_the_1986_british_social_attitudes_survey.pdf
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Appendix:  

 
How to produce the summary table of frequencies for V16 to V20  
 
Analyze > Tables > Custom Tables  
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Ignore the message: 
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Highlight v16 to v20 and drag to columns: 

 
 

 
 

Click on Compact  

 

 
 

. . then OK 
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[NB: For this example I edited the options to display variable names and values instead of labels: 

This facility is no longer available from the GUI in 18, so I had to use the following syntax 
(automatically generated by 15)] 
 
The syntax automatically  produced by SPSS for this was: 
 

TABLES 

  /FORMAT BLANK MISSING('.') /TABLES 

  (LABELS)  BY 

  ( v16 + v17 + v18 + v19 + v20 ) 

  /STATISTICS COUNT ((F5.0) 'Count' ) . 

 
The example below uses the GUI in SPSS 15. 
 
Analyze > Tables > Tables of  Frequencies 
 

 
 
Highlight the five variables: 
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and click on  ► to drag them to the Frequencies box: 

 

 
 
Press  OK  to run the job and get the table. 

 

 

Q4: (col 
16) 

Q4: (col 
17) 

Q4: (col 
18) 

Q4: (col 
19) 

Q4: (col 
20) 

Count Count Count Count Count 

1 105 1       

2 19 109 2     

3 11 4 46     

4   7 2 19   

5 6 7 21 6 37 

6 11         

 

 
 
 


